
What’s New in Adarian Money™ for Palm OS®  © 2003-2006, Adarian Software, LLC 

Version 3.8 

 Data Encryption 

To better protect your data, v3.8 employs Blowfish encryption algorithm 
to your data when you have assigned a password to your database. To 
minimize the time and memory for encryption/decryption, Money also 
lets you specify which parts of the program are to be encrypted. A new 
group Security is added to the Preferences dialog box, and the original 
Security command is renamed to Passwo d. r

 Manual QuickSelect 

QuickSelect is the feature where, in the New Transaction dialog box, you 
can enter only one or a few letters, the program will look in the list of 
payees, accounts, or categories to look for the first item that begins with 
the letters you have entered, and automatically put the found item in the 
text entry field. This feature works well for single-byte systems, but 
doesn’t work on double-byte systems.  

Manual QuickSelect is a way for the user to manually make the program 
to do such a search. It’s designed for double-byte systems, but also 
works on single-byte systems. 

When you have entered one or several double-byte characters, you can 
enter a Return character (a northeast-to-southwest Graffiti stroke, or 
you can use the keyboard if your handheld has one) to make the 
program to do the search. 

 

 Page 1 of 24 



What’s New in Adarian Money™ for Palm OS®  © 2003-2006, Adarian Software, LLC 

Version 3.7 

 Import/Export Through Memory Cards 

In this version, users who don’t use the PC Conduit can also import and 
export files through the memory expansion card. Files can be imported 
are QIF and OFX. Transactions can be exported in QIF and CSV formats. 
Tables can be exported in CSV, HTML, RTF, and TXT formats. 

 Purge Payees Command 

A new command “Purge Payees” is added to the List menu which can be 
used to delete inactive payees. Users can delete payees by filtering 
payees based on the last time a payee was used, or the number of times 
the payee was used. After a payee is removed, the user can optionally 
keep the payee name in the transaction’s note field. 

A new “Import” command is added under the Data menu. 

 Improved Reconciliation 

In the new design, the program displays the expected cleared balance in 
the footnote area while the user can access all the rest of the 
functionality of the program until the balance is correct. This way, while 
seeing the expected balance, the user can freely make whatever changes 
are not necessary to the data to obtain the result. 

 Auto Backup 

A new command “Auto Backup” is added. When enabled, Money will 
copy your database to memory card when exit as a backup. 
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 Other Improvements 

1. Improved performance for importing QIF/OFX files, noticeable 
especially when there are thousands of records. 

2. Insert upcoming scheduled transactions by tapping on "S" 
transactions in the Transaction Log or Account Register views. 

3. The File Manager command is changed so that the use of the 
expansion memory card is not limited to the "Adarian Money" folder 
only; the user can choose to use any folder on the card. 
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Version 3.6 

 Auto Processing for Scheduled Transactions 

A new group is added to the Preferences dialog box, the Sync with AMWin 
group. Options in this group let you decide if you want to synchronize 
data with Adarian Money for Windows. If you do, you can also decide 
which side, the PC or the handheld, will handle the automatic 
processing for scheduled transactions. 

 Other Improvements 

4. When pulling down the category, payee, and account list in the New 
Transaction dialog box, current selection status is preserved. 

 Page 4 of 24 



What’s New in Adarian Money™ for Palm OS®  © 2003-2006, Adarian Software, LLC 

Version 3.5 

 Unrealized Transactions 

Unrealized transactions are like scheduled transactions in that they 
haven't happened yet. The difference is they don’t repeat; they happen 
only once. You can enter an unrealized transaction into Money as a 
reminder to yourself that there is a transaction will happen some time in 
the future. Such transactions are not included in the calculation of 
income and expense, and do not affect the display of an account's 
ending balances. But they do affect the running balance (the balance 
shown in each row in the table) in the Account Register view.  

 Transfers as Income or Expense 

In previous versions, transfer transactions are never counted in when 
calculating income or expense. In this version, when defining an 
account, you can specify how transfers into or out from this account will 
be treated when calculating income/expense. You can select: 1. 
Transfers are not included as before; 2. all transfers into this account 
should be counted as expense; 3. all transfers out from this account 
should be counted as income. An option is added in the Preference 
dialog box so that you can decide whether this feature should be 
enabled or disabled. Your options are: 1. Disabled, that is, everything 
will be like before, transfers are not counted; 2. Enable for all accounts, 
that is, transfers are treated in the way as specified in the account 
definition as described earlier; 3. Enable only for accounts that are not 
included in the filter in effect. If there is no filter in effect, then it will be 
just like before. 

 Excluded Transaction 

A new attribute is added to transactions – Excluded. On every aspect, 
"Excluded" transactions are exactly the same as ordinary transactions 
with one exception – When a transaction is marked as Excluded, it will 
never be included in the calculation of income and expense, no matter 
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what category it has been assigned to. Setting a transaction to Excluded 
affects only the income/expense, but will never affect the calculation for 
other account-related information, such as balance, withdraw, deposit, 
transfer-in, and transfer-out.  

To support this new attribute, a new filter criteria "Excluded" is also 
added in Filter dialog box. 

 Import of OFX Files 

In addition to QIF files, now you can import transactions from OFX 
(Open Financial Exchange) files. 

 Other Improvements 

5. A pair of buttons is added to the left of the View menu to let you 
easily navigate back and forth among views. 

6. In this version, unrealized and upcoming scheduled transaction will 
also be displayed in the Transaction Log view. A few new options are 
added to the Preferences dialog box to select the range. 

7. A new repeating option for scheduled transactions is added: the 
“Every weekday” option. 

8. Cash flow chart’s date range selection is made to be more flexible. 

9. Items in the footnote of the Account Register and Accounts List 
views are changed. 
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Version 3.0 

 HotSync with Adarian Money for Windows 

The only change in this version is the support of seamless 
synchronization with Adarian Money for Windows v3.0. There is no 
added (or changed) user interface or operation in terms of the Palm OS 
version. 

The PC Conduit has changed to support this new feature. 
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 Version 2.6 

 Multiple Databases 

With this new feature, Money allows the user to create and manage 
more than one database in the memory. For example, the user can 
create a database for his own personal money, another for his business 
expenses.   

 

Please refer to the User’s Manual for more details on this feature. 
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Version 2.5 

 Pie Chart view 

A new view is added in this version -- the Pie Chart view. In this view, the 
program uses a pie chart to show the incomes and expenses based on 
categories, payees, or classes. 

 

 Improved budgeting 

Instead of using the same budget for every month, you can now specify 
different budget for each month in the year: 

       

Also, unused budgets or overage in the last month can be “rolled over” 
to the next month by using the Roll Over command from the Data menu 
when you’re in the Categories/Budget view. 
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Because of this change, weekly budgets are no longer supported in this 
version. 

 Future Transactions in Register view 

In the Account Register view, future transactions of an account as 
specified using the Scheduled Transaction command will be shown at 
the bottom so that you can get to know how the account balance will 
change in the future. Future transactions are marked with an “F”; you 
can use the Preferences command to select how many days into the 
future to show, or simply disable this feature. 

 

 Other improvements 

1. In the Preferences dialog box, there is a new option “Work on temp 
database.” When checked, every time you enter Money, Money 
creates a working copy of the main database. All the changes you 
made in Money will be in this temporary database. Only when you 
exit and if the temporary database is undamaged, will Money copy 
the contents in this temp database to the main one. This option 
helps ensure the safety of your data. 

2. When defining a filter, if you’re using criteria on accounts, categories, 
payees, or classes, now you can select more than one item in the 
definition.  Also, in this dialog box, you can use Graffiti or the built-in 
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keyboard to enter a letter, the list will jump to the item that starts 
with the letter you entered. 

 

3. Added an Apply button in the Filter Manager dialog box, so that you 
can select a filter and apply it right away. 

4. In the Transaction dialog box, two arrow buttons are added to make 
it easier to select a date just a few days away. 

 

5. In the Exchange Rate dialog box, among the three factors (original 
amount, exchange rate, and converted amount), you can choose to 
select any two of the three, and let the program calculate the third 
for you. 

 

6. Two new commands are added to the Options menu: Expand All and 
Contract All. These two will appear only when you’re in the 
Categories/Budget view. They can be used to expand or contract all 
sub-categories. 

7. One new command is added to the Options menu: Zero Items. This 
command appears only when you’re in Categories/Budget, Payees, 
or Classes view. It can be used to show or hide items whose amounts 
are 0. 
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8. Increased the maximum number of accounts in an account group 
from 20 to 30. 
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Version 2.2 

 Trend view 

A new view is added in this version -- the Trend view. It shows the 
monthly/weekly/daily trend in income and expenses. With a proper 
filter, you can easily find out the trend on a particular category or payee 
or anything. 

 

 Custom Views for charts 

In previous version v2.0, the Cash Flow view cannot be used as the base 
view of custom views. In this version, a new Trend view is added, and 
these two chart-based views can both be used as the base view for 
custom views. 

 Beaming of transactions 

In previous versions, Adarian Money can only beam list items such as 
accounts, categories, etc. In v2.2, beaming of transactions is supported. 
You can select which transactions to beam. However, one prerequisite 
must be satisfied: list items used in the transactions must already exist 
in the receiving side. For example, if a transaction is from account 
“AMEX”, then on the receiving side there must also exist an account 
called “AMEX.”  
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 New options in the PC Conduit 

Two new options are added to the PC Conduit: One allows you to 
disable or enable the export function. The other lets you choose the date 
format used in import QIF files. 

 

 Importing statuses from QIF files 

In previous versions, the status of imported transactions are always 
marked as an “o” in Transaction Log or Register view. In this version, an 
option is added to let you select if you want to set the status to: Posted, 
Cleared, Reconciled, For review (same as in previous versions), or set to 
the status that are used in the QIF file. 
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  “Show Years” option 

A new option is added in the Preferences so that you can show the year 
part in dates in all columns that display dates. This may be useful for 
those lucky ones who have wide-screen Palms. I envy you. 

 

 Usability improvements 

  Auto Fill-In in Transaction dialog box  

When you enter or modify a transaction, Money remembers the 
association between the payee and other attributes, namely category, 
account, and class. Next time when you are entering or modifying a 
transaction, if you select the payee, these three attributes will be filled in 
automatically. This can save you the effort of entering the same 
information again. 

This feature can be disabled by unchecking an option in the Preferences 
dialog box. 

  QuickSelect Improvements  

10. Key-to-Select   In the Transaction dialog box, when a QuickSelect 
list is showing (i.e., the Categories, Accounts, and the Payees list), 
you can enter a letter using Graffiti or keyboard to make the item 
that starts with the letter be selected. List is automatically scrolled if 
necessary.  

11. Tap-to-Select   When tapping on a QuickSelect field (the dotted 
underline area where you can enter text), all text in it will become 
selected. This makes it easier if you want to replace the text in there. 

12. Scroll Bar    The scroll bar to the right of a QuickSelect list is made 
easier to aim and scroll. 
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  Retain current position in the Categories/Budget view  

The table does not scroll after the date range is changed. 
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Version 2.0 

 Cash Flow view 

One more built-in view is added: the Cash Flow view. This view shows 
an account’s (or a group of accounts) daily ending balances in a line 
chart. If there are upcoming scheduled transactions, they will be 
included to obtain future balances. 

       

 Account Groups 

In Cash Flow and Accounts List views, you can group accounts into 
Account Groups. When in the Accounts List view, only accounts in the 
selected group are displayed, and from the footnote you can get to know 
the total balance of these accounts. For example, a group “All credit 
cards” can be used to check the total balance of all your credit cards. 

     

Similarly, in Cash Flow view, you can use this group to see the changes 
on total daily balance for all your credit cards. 
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 Expand/Contract sub-categories 

In the Categories/Budget view, add a column to show zoom in/out 
buttons at the front. The user can use these buttons to expand or 
contract sub-categories. When sub-categories are hidden, the budget 
and actual spending shown in the parent category row are the sum of all 
its children categories. 

 

 Shared budget for sub-categories 

An option is added so that sub-categories do not have to have their own 
budgets, they can share their parents’ budgets.  For example, you can 
assign a lump sum of $100 to the main category Auto, this $100 is 
allocated for category Auto and all its sub-categories. 
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 Keep sub-categories together when sorted 

In the Categories/Budget view, when you sort on any column (like 
Budget, Actual, Remain, etc.), Money will first sort the main categories, 
then sort sub-categories. This way, a main category’s sub-categories will 
still be kept together after sorting. 

In the following picture, categories are sorted by their budgets in 
ascending order. Note that main categories are in order, and the three 
sub-categories of “Vacation” are still under their parent and also sorted 
by ascending budget.  

 

 Quick Access Buttons 

In the previous version, Money has this Quick Access Keys which you 
can enter a Graffiti letter to quickly switch to a view. But some models of 
Palm PDA can’t use Graffiti when the screen is extended to 320x450 or 
450x320 modes. In this version, we added a row (or column) of Quick 
Access Buttons at the bottom (or rightmost part) of the screen. Tapping 
on these buttons have the same effect as using Quick Access Keys.  
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These buttons show only when the screen is extended. And there is an 
option in the Preferences to show/hide these buttons. 

 Retain foreign currency’s original amount and exchange rate 

When a transaction is made using a currency different from that of the 
account’s, Money will always remember the original amount and the 
exchange rate used. By default, the exchange rate will be the same as the 
one set up in the Currency list. But can also overwrite that default rate 
by specifying a different on when entering a transaction. To do so, in the 
Transaction dialog box, select Exchange Rate command from the 
currency pop-up list, then another dialog box appears where you can 
enter the exchange rate and foreign currency amount: 

 

When you’re back to the Transaction dialog, both amounts will be 
shown: 

 

In order to let you view the foreign currency amount and the exchange 
rate, two columns are added to the Transaction Log view and the 
Account Register view. Also, a new criteria Original Amount is added to 
the filer definition so that you can find transactions with original 
amounts and exchange rates. 

 Automatically add non-existent items 

When entering or modifying a transaction, now you can enter accounts, 
categories, and payees that do not already exist in the database. Money 
will ask you if you want to create them. 
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 Duplicate transactions 

When tapping on a transaction in the Transaction Log or Account 
Register view, you will be brought to the Transaction dialog box to 
modify it. In this dialog box, the Mod fy (used to be the OK button) and 
Delete buttons are already available in the previous version. In v2.0, we 
added a Dup button, see the picture on the left. Tapping on the Dup 
button, Money turns the dialog box from modification mode to insert 
mode (see the picture on the right.) All the fields in the dialog box will 
remain the same except the date is changed to today’s date. And when 
you tap on the OK button, a new transaction is inserted into the 
database. 

i

     

 Quick view of notes 

A column of note icons is added to Transaction Log, Account Register, 
Accounts List, Categories/Budget, Payees, and Classes views. You can 
tap on the note icons to view the first 4 lines of note text attached to a 
transaction, category, payee, or class. 
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 Add a column in the Scheduled view 

A new column is added to the Scheduled view to display the account 
where the scheduled transaction will come from. 

 Directly access the Swap sub-menu 

The Swap sub-menu in the Table’s menu is a very often used item. To 
make it easier for you, this version added the ability to access this sub-
menu directly: Press and hold down the stylus anywhere inside the table 
header for over 0.5 seconds, the Swap sub-menu will pop up directly. 

  “Transfer Money” as payee when exporting to Quicken 

Add an option in the PC Conduit so that “Transfer Money” is used as the 
payee when exporting directly to Quicken. 
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Version 1.2 

 Support for high-res handhelds 

When run on high-resolution handhelds, you can choose from eight 
built-in fonts to be used in the table. These fonts include small fonts so 
that more rows and columns can be displayed at a time. 

 

 Support of navigation buttons 

This version supports buttons, include palmOne’s 5-way navigator and 
Sony’s JogDial. 

 Arithmetic calculator 

An arithmetic calculator is added in this version. In almost every place 
that needs to enter a number (such as amounts, budgets, opening 
balances, etc.), you can use the calculator so that 1. you don’t have to 
use Graffiti any more, and 2. you can do some calculations and enter the 
result right into the field. 
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 Loan calculator 

A loan calculator is added so that you can calculate loans or mortgage 
without buying another program. 
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